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P R E F A C E

About This Guide
Conventions Used in This Document
The style conventions used in the printed and PDF format of this 
document do not necessarily apply to other formats. During 
conversion to HTML, some of these conventions may be lost.

This document uses the following graphical and typographical 
conventions:

! Admonitions

! Key combinations

! Special fonts and capitalization

Admonitions

Note, Tip, and Warning paragraphs draw your attention to additional 
information which may help you avoid losing data or time.

Note:  Notes contain additional information about the 
current topic.

Tip:  Tips contain suggestions that may save you time or 
effort.

Warning:  Warnings contain critical information that you 
need to understand before proceeding. Ignoring 
information in a warning may cause loss of data or time.
Preface: About This Guide iii
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Key Combinations

Key combinations (such as Ctrl+O) are presented throughout this 
document and should be used in the following way:

1. Press and hold the first key.

2. Press the second key.

3. Release both keys.

Special Fonts and Capitalization

Two special fonts have been used to distinguish between user input 
and computer output:

! Command

All commands or data to be entered on an on-screen data entry 
line appear in bolded Courier font. This may include 
commands used with options, paths to directories or files, or 
other simple input, such as filenames.

! Code

Any code sample, including command output, is shown in 
Courier font.

The following capitalization rules apply to Linux filenames, Linux 
commands, and English names of on-screen buttons and keyboard 
keys.

! Linux filenames and commands are case-sensitive. In most 
instances, they are lowercase. When you enter a filename or 
command, use the same case that appears in your instructions 
or examples.

! When procedures refer to a particular on-screen button, the 
name of the button appears in uppercase (such as in SAVE), 
regardless of how it appears on the screen.

! When procedures refer to a particular key on a keyboard, only the 
initial key is capitalized (such as the Tab key), just as it appears 
on a U.S. standard keyboard. This also applies to key 
combinations.
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Additional Resources
The following resources are available to provide you with additional 
support. 

! Embedix SDK Getting Started

! Embedix SDK Target Wizard User Guide

! Embedix SDK Reference Manual

! Embedix RealTime Programming Guide

! Lineo™ Support Web site

http://www.lineo.com/support

Note:  Most printed manuals that ship with Lineo products 
are also available in PDF and HTML formats on the product 
CD-ROM and the Lineo Web site.
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C H A P T E R 1 Installing and Running the Analyzer
This chapter covers the following topics:

“Introduction” on page 1
“Installing LTOP” on page 2
“Adding LTOP Functionality to an Existing Project” on page 3
“Adding LTOP Functionality to a BSP Add-on” on page 3
“Running LTOP on the Host Machine” on page 4
“Running LTOP on a Remote Target” on page 6

Introduction
Graphical Remote Process Analyzer 2.0 provides a tool named LTOP, 
which is a monitor that displays the status of the processes currently 
in existence. It is much like the Linux utilities top or ps, but with a 
graphical user interface. 

LTOP can be used to monitor either the host system or a target 
system running the ltop_target client software. The graphical 
user interface uses the Qt toolkit.

Requirements

In order to monitor both host and target Linux systems, meet the 
following requirements:

! Host: Must be a Linux machine that is running Embedix SDK 2.0 
or higher. 

! Target: Must have a properly set up ethernet connection.
Chapter 1: Installing and Running the Analyzer 1
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Installing LTOP
These instructions assume that you have already installed Linux and 
Lineo® Embedix® SDK 2.0 (or higher) on your host machine and 
have a basic understanding of the GNOME desktop environment. 

Note:  If you are using this tool only to analyze your host 
system, you do not need Embedix SDK installed.

1. Start your computer and run Xwindows as the root user. 

Most Linux desktop distributions will automatically run 
Xwindows on startup and allow you to select the user account.

2. Start an Xterm. 

Most Linux desktop distributions provide an Xterm launch icon 
in the system menu bar you can click to start the Xterm.  The 
icon usually looks like a small computer terminal. 

3. Insert the Graphical Remote Process Analyzer CD-ROM into the 
CD-ROM drive. 

Some systems automatically mount the CD-ROM when 
inserted.  If your CD-ROM is automounted, skip to Step 5.

4. Mount the CD-ROM by entering the following command:

        mount /mnt/cdrom -o exec

If you set up your Linux system CD-ROM drive with a different 
device name, use that device name in place of "cdrom" in the 
command above.

5. Change your directory location to the /mnt/cdrom directory by 
entering the following command:

        cd /mnt/cdrom

6. Run the installation script by entering the following command:

        ./install.sh

A wizard launches and guides you through installation options.
2 Embedix Graphical Remote Process Analyzer User’s Guide
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7. After selecting your desired options, click FINISH.

LTOP will be installed on your computer. When the installation 
is complete, you are returned to the Xterm command line.

Adding LTOP Functionality to an Existing Project
To add LTOP functionality to a Target Wizard project that was created 
before LTOP was installed, modify the bsp_config file located in your 
project directory as outlined in the following steps. 

1. With root permission, open the bsp_config file located in: 

~/project/<project_name>/config-data/
buildcontrol/board

2. In the %ecdlist field, add the following entry to the end of the list:

ltop_target.ecd

3. Save your changes.

4. Restart Target Wizard to see this addition.

Adding LTOP Functionality to a BSP Add-on
To add LTOP functionality to a BSP that was installed after LTOP was 
installed, modify the bsp_config file located in the BSP (or board) 
directory as outlined in the following steps:

1. With root permission, open the bsp_config file located in: 

/opt/Embedix/bsp/<boardname_dir>/config-data/
buildcontrol

2. In the %ecdlist field, add the following entry to the end of the list:

ltop_target.ecd

3. Save your changes.

4. Restart Target Wizard to see this addition.
Chapter 1: Installing and Running the Analyzer 3
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Running LTOP on the Host Machine
After you have installed LTOP on your host system, you can run the 
tool in the host mode immediately.  As a root user, simply open an 
Xterm window and enter the following command: 

ltop 

The tool will launch (much like the sample screenshot below) and 
allow you to investigate processes on the host machine. 

The source code is included on the CD, but is not installed.  You may 
copy the host source code to a directory if you desire.

For an orientation to the user interface and use instructions, refer to 
Chapter 2, “Using the Analyzer.”

Syntax

You can start LTOP from the command line using the following 
syntax: 

ltop [OPTIONS]

Enter ltop -help to view command-line options and then return 
to the command-line prompt. Refer to the Table 1-1 on page 5 for 
additional startup options. 
4 Embedix Graphical Remote Process Analyzer User’s Guide
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Options

LTOP has several startup options to choose from that allow you to 
customize the way the user interface displays on your screen..

Table 1-1. LTOP Options

Option Description

-display <display><display><display><display> Sets the X display (default is $DISPLAY)

-geometry <geometry><geometry><geometry><geometry> Sets the geometry of the main window of ltop

-background <color><color><color><color> Sets the default background color and an application 
palette (light and dark shades are calculated).  This may 
not function with all colors.

-foreground <color><color><color><color> Sets the default foreground color. This has limited use as 
well.

-target <name><name><name><name> Start ltop with "name" target for information source.

-title <title><title><title><title> Sets the application title (caption).

-style <style><style><style><style> Sets the application GUI style. Possible styles are motif 
and windows.  (If you are using Qt 2.x, the styles cde and 
platinum are also available.)

-font <font><font><font><font> Sets the application font

-iconic Starts the application iconified.

-version Prints the version of ltop and the Qt library, and exits.

-help  Prints a summary of command-line options and exits.
Chapter 1: Installing and Running the Analyzer 5
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Running LTOP on a Remote Target
In order to analyze a target system, build the target software into a 
project before deploying the image to the target.  You can do this by 
completing the following steps.

1. Build the target software into the project:

1a. On the host system, initiate a Target Wizard session as 
regular user (not root): At the shell prompt, enter: tw 

1b. Create or open a project.

1c. In the project’s tree view, navigate to 
/Embedix/Programming/Debugger/ltop_target

1d. Enable the ltop_target node and then rebuild your 
project.  

2. Deploy the target image to the target board. Use a deployment 
method that allows you to access a shell prompt on the target.

3. At your target shell prompt, enter the following:

/usr/sbin/ltop_target

After a log message displays, you should see the following:

: Success

4. If you haven’t already launched LTOP on your host machine, do 
so now by entering the following command at the host’s shell 
prompt:

ltop

5. From the LTOP menu bar, choose Target and then enter the 
IP address or target name in the box provided.  

The tool should display process information about the target.
6 Embedix Graphical Remote Process Analyzer User’s Guide
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C H A P T E R 2 Using the Analyzer
This chapter covers the following topics:

“Exploring the User Interface” on page 7
“Using the Analyzer on a Remote Target” on page 21
“General Information” on page 22

Exploring the User Interface
When you launch LTOP from a host command line, the LTOP main 
window appears (much like the following screenshot).

The main window these sections, which are discuss in this section: 

“Menu Bar” on page 11
“System Summary Area” on page 8
“Process Table” on page 8
Chapter 2: Using the Analyzer 7
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System Summary Area

This portion of the interface is a dynamic summary of all processes 
on your system. It is set to a graphical display by default, but you can 
change it to a text format (see the menu item Options > Preferences).

When the System Summary has the graphical display enabled, four 
types of informaton are displayed here: 

! CPU status (shown in a status bar)

! CPU usage breakdown (a legend helps you deciphers the 
shading for the bar chart readout)

! Memory usage breakdown (a legend helps you deciphers the 
shading for the bar chart readout) 

! Swap usage (shown in a bar chart)

Process Table

The following topics related to the Process Table are discussed in this 
section:

“Linear View or Tree View” on page 8
“Show or Hide Portions of the Tree View” on page 9
“Column Headers” on page 9
“Sorting the List” on page 10
“Customizing Columns” on page 10
“Selecting Processes” on page 10
“Context-sensitive Menus” on page 10
“Monitor a Single Task” on page 10
“Identify Processes with a Common Value” on page 11
“Keyboard Shortcuts” on page 11

Linear View or Tree View

At the top of process table, you can choose to view the process list in 
the Linear view or the Tree view (the default is Tree view).
8 Embedix Graphical Remote Process Analyzer User’s Guide
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Show or Hide Portions of the Tree View

In the Tree view, the parent-child relationships between processes is 
shown in an obvious way.  Click on the triangles to show or hide an 
entire subtree.  Sorting affects only siblings; the tree structure 
imposes the global order.

Column Headers

If you hover the mouse cursor over one of the column headers, a 
short description of that column is displayed after a few seconds. 
Most of the column descriptions are self-explanatory. The exceptions 
that required more discussion are USER and WCHAN, which are 
described in greater detail here.

! The USER column shows the real user ID.  If the effective user 
ID of a process is different from its real user ID, a plus sign (+) 
is appended to the user name; if it is the super-user, an asterisk 
(*) is appended.

! For displaying the WCHAN column as symbols on the host 
machine, the kernel symbol file System.map is needed. LTOP 
will search for it in the following locations:

/boot/System.map-RELEASE
/boot/System.map
/lib/modules/RELEASE/System.map
/usr/src/linux-RELEASE/System.map
/usr/src/linux/System.map
/usr/local/src/linux-RELEASE/System.map
/usr/local/src/linux/System.map

where RELEASE is the kernel release number, for instance 
"2.0.29". If the System.map file isn't found or is unreadable, 
hexadecimal addresses will be displayed instead. The prefixes 
"sys_" and "do_" are stripped from the symbols before they are 
displayed.  The target symbol names are currently not supported 
and hexadecimal addresses will always be shown.
Chapter 2: Using the Analyzer 9
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Sorting the List

The process list in the process table is sorted by the selected column 
heading. Click on another heading to change the sort; click the same 
column heading again to reverse the sorting order. 

Customizing Columns

Rearrange the columns as you like by dragging and dropping the 
heading. To add/remove a column to/from the display, click on the 
process title bar and choose an add or remove column option.

Selecting Processes

Click on a process in the list to select or deselect it.  Shift+click to 
select multiple processes.  

Context-sensitive Menus

Right-click on a selected process to open a context-sensitive menu (or 
shortcut menu), which duplicates some functions from the main 
menu for convenience.  It works both on processes and on the 
column headings.  

Monitor a Single Task

One feature unique to the context-sensitive menus is the Monitor 
Task option.  Choose this option to open a seperate display of 
memory and CPU usage of that process, as seen in the following 
sample.
10 Embedix Graphical Remote Process Analyzer User’s Guide
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Identify Processes with a Common Value

Ctrl+Shift+click on a table cell to select all processes with the same 
displayed value in the particular column.  For instance, to select all 
processes with the “S” status, press and hold the Control and Shift 
buttons, then click on one instance of “S” in the STAT column. All 
processes in the list with the “S” status are highlighted. In the 
following sample screen, getty and sh would be highlighted as well 
as their parent, Init.

Keyboard Shortcuts
Alt+W: Close the active window (except the main window)
Q or Alt+Q: Quit ltop.
Space Bar: Force an update of the displayed tables.
Crtl+Z: Iconify ltop.

Menu Bar

The menu bar consists of the following menus: Process, Signal, 
View, Command, Options, Target, and Help. For more information 
on these menus, see the following pages:
Chapter 2: Using the Analyzer 11
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“Process Menu” on page 12
“Signal Menu” on page 14
“View Menu” on page 16
“Command Menu” on page 17
“Options Menu” on page 19
“Target Menu” on page 21
“Help Menu” on page 21

Process Menu

The Process menu provides the following options:

! Renice: To change the time-sharing priority of the selected 
processes, enter the new priority in the Renice... dialog. The new 
nice value should be in the range -20 to 20; 0 is the default. A 
larger number means that the process gets less CPU time.  Only 
the super-user may decrease the nice value.  The nice value can 
only be changed on the host, not the target.

! Change Scheduling: The Change Scheduling... dialog allows the 
super-user to change the scheduling policy of the selected 
processes (using Posix.1b scheduling control).  Normal 
processes are set to SCHED_OTHER and have static priority 0; 
(soft) real-time processes have the policy SCHED_FIFO or 
SCHED_RR and a static priority in the range of 1 to 99.  (See 
sched_setscheduler(2).)  This option also only functions on host 
processes, not target.

! View Details: The View Details menu item opens a window that 
shows different aspects of the selected processes (similar to the 
screenshot below).  Double-clicking on a process has the same 
effect. 
12 Embedix Graphical Remote Process Analyzer User’s Guide
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All information is available to the owner of the process (and to 
superuser). (If you start LTOP as a regular user [not root], a 
warning is displayed, but no other indication is given during tool 
operation.  It is best to start LTOP and run it as superuser.)

When you choose View Details, you may have as many as five 
tabs display, which are all described here:

" The Sockets tab shows the currently used TCP and UDP 
sockets. If Host Name Lookup is checked in the Preferences 
dialog, a host name lookup will be done for each IP address. 
This is done by a background process and can take a while 
for difficult cases (once looked up, addresses are cached).

" The Memory Maps tab shows the process's memory 
mappings.  In Linux 2.0.x the file names are not given.  
Anonymous mappings (allocated memory not bound to a file 
or device) are marked (anonymous).

" The Files tab shows the process's open files.  In Linux 2.0.x, 
the files are given on the form [AABB]:inode, where AA and 
BB are the device major/minor numbers in hexadecimal.  
Chapter 2: Using the Analyzer 13
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" The Environment tab shows the process's environment 
variables.  Note: this is the environment with which the 
process was started, not necessarily incorporating later 
changes.  Some processes that modify their command line, 
notably sendmail(8) and ftpd(8), may use the environment 
space for this, showing nonsense in this tab.

" The All Fields tab shows the value for all the variables that 
could be displayed in the main LTOP window.  It is useful for 
seeing the entire process setting without enabling all fields 
in the main window.

! Find Parent and Find Children will select the parent/children of 
the selected processes, and center the table on the first of them.

! Find Descendants will select the tree of all children of the 
selected processes.

Signal Menu

The Signal menu allows the user to send many different types of 
signals to the process.  It issues these signals via the kill(pid, 
signal) command. 

The menu contains the most common signals, but you can easily 
access other signal options by choosing the menu item Other.

The Signal menu items are:

! Terminate (SIGTERM)

! Hangup (SIGHUP)

! Stop (SIGSTOP)

! Kill (SIGKILL)

! Other

The additional signal options are listed in Table 2-1 and a key for its 
Action column can be found in Table 2-2.
14 Embedix Graphical Remote Process Analyzer User’s Guide
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Table 2-1. Signal Options

Signal Value Action 
(Table 2-2)

Comment

SIGTERM 15 A Termination signal

SIGHUP  1 A Hangup detected on 
controlling terminal or death 
of controlling process

SIGSTOP 17,19,23 D,E,F Stop process

SIGKILL 9 A,E,F Kill signal

SIGINT 2 A Interrupt from keyboard

SIGCONT 19,18,25 Continue if stopped

SIGQUIT 3 C Quit from keyboard

SIGILL 4 C Illegal Instruction

SIGABRT 6 C Abort signal from abort(3)

SIGFPE 8 C Floating point exception

SIGSEGV 11 C Invalid memory reference

SIGPIPE 13 A Broken pipe: write to pipe with 
no readers

SIGALRM 14 A Timer signal from alarm(2)

SIGUSR1 30,10,16 A User-defined signal 1

SIGUSR2 31,12,17 A User-defined signal 2

SIGCHLD 20,17,18 B Child stopped or terminated

SIGTSTP 18,20,24 D Stop typed at tty
Chapter 2: Using the Analyzer 15
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View Menu

The View menu allows the user to change the characteristics of the 
Process Table. 

You have two groups of view options to choose from:

! The first group includes: All Processes, Your Processes, None-
Root Processes, and Running Processes.

The All Processes selection will display all processes on the 
selected machine. The Your Processes selection determines who 
involked ltop and will display only those processes owned by 
user. None-Root Processes display only those processes which 

SIGTTIN 21,21,26 D tty input for background 
process

SIGTTOU 22,22,27 D tty output for background 
process

Table 2-2. Signal Options Action Key

Action Key

A Default action is to terminate the process.

B Default action is to ignore the signal.

C Default action is to terminate the process and dump 
core.

D Default action is to stop the process.

E Signal cannot be caught.

F Signal cannot be ignored.

Table 2-1. Signal Options

Signal Value Action 
(Table 2-2)

Comment
16 Embedix Graphical Remote Process Analyzer User’s Guide
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are not being executed with root permissions. Running 
Processes displays the processes that are currently executing.

! The second group includes: User Fields, Job Fields, Memory 
Fields, Select Fields, and Save Settings Now.

These determine a predefined set of columns that can be 
displayed.  Depending on the information required at the 
moment you can select the User Fields, Jobs Fields, or Memory 
Fields.  Each option will display or undisplay columns that are 
pertinent to the selected Field.  Use the Select Fields option to 
add or subtract from the defaults above.  The Save Settings Now 
option in the Options menu will save your choices after you have 
the tool setup with your preferences.

Command Menu

The Command menu has an Edit Commands... option as well as a 
list of customized commands. 

The Edit Commands... option launches another window that allows 
you to customize the Command menu for your use. You can choose 
to add, edit, or delete menu items. 

There are three default commands listed here besides the Edit 
Command option: gdb, strace, and remote strace.

The gdb command allows the user to open a debugger on a process 
currently running on the host machine.  This option is not available 
for remote processes. 

The strace and remote strace commands start an Xterm with the 
process selected being the system traced.  Strace must exist in order 
for these options to function. 

Customize the Command Menu

To customize the Command menu, complete the applicable steps 
below:

1. From the menu bar, choose Command > Edit Commands...
Chapter 2: Using the Analyzer 17
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A list of the current menu items appears, as in the following 
example:

2. To add a command to the menu, click ADD, add your entry to the 
Command Line box, and then click OK.

3. To delete a command from the menu, highlight the command in 
the and then click DELETE.

4. To edit a command in the menu, highlight the command in the 
list, click EDIT, edit the Command Line box as needed, and then 
click OK.

For example, if you were to choose to edit the strace command, 
the following Edit Command dialog box would appear:

Notice the Substitutions listed on the screen. 
18 Embedix Graphical Remote Process Analyzer User’s Guide
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Tip:  Use existing commands as a guide to get you started.  It 
usually works best to spawn another window to display 
information in. 

The "Description" of each command is what appears in the 
menu; the "Command Line" is a shell command (executed with 
/bin/sh). Before the command is passed to the shell, the 
following substitutions are made:

Any other % + letter combination is removed. The command 
line will be run once for each selected process (in unspecified 
order).

Options Menu

The Options menu contains the selections that can be used to set the 
display.  These settings are saved in:

~/.ltop-settings

The Option menu items are:

Update Period...
Hide/Show Status Bar
Hide/Show Control Bar
Hide/Show Command Path
Include Child Times
Preferences

By default, the process display updates every 5 seconds. To change 
the host update rate, type the new update period in the Update 

%p with the PID (Process ID) of the selected process

%c with the short command name of the process

%C with the complete command line of the process

%u with the name of the (real) owner of the process

%% with a literal '%'.
Chapter 2: Using the Analyzer 19
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Period... dialog.  The units min, s and ms may be used (if none, 
seconds are assumed).  You can force an update by pressing the 
space bar or clicking the Update button. LTOP will consume a lot of 
CPU time if the update period is short or zero.  If iconified, however, 
LTOP will use very little CPU time.  The target update rate is set to 5 
seconds and cannot be changed, however the update button does 
force an update manually.

The Hide/Show Status Bar, Hide/Show Control Bar will turn on or 
off parts of the main display.

The Hide/Show Command Path turns the path information on or off 
in the CMDLINE column.

If Include Child Times is selected in the Options menu, the TIME 
field will show the sum of the CPU times used by the process and all 
of its children.

The Preferences selection brings up another window that has 
various selections.  There are several options that are are pretty much 
self-explainatory.  (See the following screenshot.)
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The main window is automatically updated when you select an 
option here so you can the effects of your selections immediately.  
The following is a description of some of the options in this window.

The load, CPU, memory and swap displays in the status bar can be 
toggled between graphic and text representations by clicking on 
them, or by settings in the Preferences...dialog.  The load numbers 
shown are the number of jobs in the run queue averaged over 1, 5 
and 15 minutes.  On SMP (multi-CPU) machines running Linux 
2.1.x or later, the CPU stats will be shown for each processor in 
vertical mode, and the average of all CPUs in horizontal mode.

The swap bar will turn red if free swap space falls below a certain 
value, which can be changed in the Preferences... dialog.  The 
number can be entered in K, M (megabytes) or % (percent of total 
swap space).  The default is 10%.

Target Menu

The Target menu is used to switch back and forth from viewing 
details about the host machine (Local) to a target machine (Target).  
The default view is Local. To view the target, you may need to enter 
the IP address. Occasionally garbage will displayed until the next 
update occurs.  You can click the UPDATE button (at the top-right of 
the Process Table) to force an update.

Help Menu

The Help menu provides standard help menu options.

Using the Analyzer on a Remote Target
The LTOP client software must be running on the remote machine 
in order to use the remote information display part of the tool. 

The ltop_target executable installs to the /usr/sbin directory 
during deployment.  There is a configuration file called 
ltop_target.cf in the same directory.  The configuration file 
defines the port number, logfile, authorized users, and daemon flag. 
Default settings work under most conditions. The entries in the 
ltop_target.cf file are explained in the following list:
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! The tcp port number is 5123.

! The daemon flag can be set to "y" or "n".  If it is set to "n" the 
process will not background itself and will remain in the 
foreground of the window where it was started.  This is useful if 
ltop_target is not functioning properly.

! The logfile may contain some debugging messages. The default 
path is /var/log/ltop_target.log. 

! host_users should contain localhost and root.  You can add your 
username if you want to run the tool with your own permissions. 
This tool must be executed as root.

General Information
This section contains some general information about the software.

Authors
Mattias Engdegard and Matt Waddel (mattw@lineo.com)

License

The host portion of LTOP is open-source software and may be 
redistributed under certain conditions. See the GNU General Public 
License for details.

The target portion of LTOP is Lineo proprietary software and 
requires compliance to the end user license agreement (EULA) that 
ships with the software.

Known Issues

After using the Target menu to switch from remote target mode to 
local (or host) mode (or vice versa), the commandline field may 
display garbage.  Clicking the UPDATE button will refresh the fields 
with the proper display.

The CPU indicator in the status bar will display nonsense in SMP 
systems running Linux 2.0.x due to a kernel bug.
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